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Warranty
A. Limited Warranty Statement

1 Matrox Electronic Systems Ltd. (“Matrox”) warrants to the end-user customer who provides adequate proof of 
purchase, that Matrox hardware products purchased from Matrox authorized dealers will be free from defects in 
materials and workmanship for a period of three (3) years from the date of purchase. This warranty applies only 
to the original end-user purchaser and is non-transferable. Conditions and limitations of Matrox’s warranty are 
stated below.

2 Matrox’s limited warranty covers only those defects that arise as a result of normal use of the hardware and does 
not apply to any:
a improper or inadequate maintenance;
b incompatibilities due to the user’s hardware or software applications with or in which the Matrox product 

interfaces;
c product of a special or custom-made nature;
d unauthorized modification or misuse;
e improper installation, misapplication or negligence;
f operation outside the product’s environmental specifications;
g improper site preparation or maintenance;
h software;
i other causes that do not relate to a product defect;
j defects or damage suffered as a result of force majeure (including theft);
k defects or damage suffered as a result of normal wear and tear; and/or
l stolen goods.

3 If Matrox receives, during the applicable warranty period, notice of a defect in a warranted hardware product and 
the defective Matrox product in question, Matrox shall at its sole option, either repair or replace the product, and 
shall return the repaired product or a replacement product within a reasonable delay. The replacement product 
may not be new, provided that it has functionality at least equal to that of the product being replaced.

4 This warranty is valid in any country where Matrox hardware products are distributed by Matrox or its 
authorized dealers.

5 This Limited Warranty Statement gives the customer specific legal rights. The customer may also have other 
rights which vary from state to state in the United States, from province to province in Canada, and from country 
to country elsewhere in the world.

B. Limitations of Warranty
1 NEITHER MATROX NOR ANY OF ITS THIRD PARTY SUPPLIERS MAKES ANY OTHER WARRANTY 

OF ANY KIND, WHETHER EXPRESSED OR IMPLIED, WITH RESPECT TO MATROX PRODUCTS. 
MATROX SPECIFICALLY DISCLAIMS (and the customer, by accepting the Matrox product, specifically 
accepts such disclaimer and waives) ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR OR INTENDED PURPOSE OR USE AND THE WARRANTY AGAINST 
LATENT DEFECTS, WITH RESPECT TO THE HARDWARE AND/OR SOFTWARE. MATROX FURTHER 
DISCLAIMS ANY WARRANTY THAT MATROX PRODUCTS, IN WHOLE OR IN PART, WILL BE FREE 
FROM INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY OR PROPRIETARY 
RIGHTS."

2 To the extent that this Limited Warranty Statement is inconsistent with the law of the locality where the 
customer purchases the Matrox product, this Limited Warranty Statement shall be deemed modified to be 
consistent with such local law. Under such local law, certain limitations of this Limited Warranty Statement may 
not apply to the consumer.

3 To the extent allowed by local law, the remedies provided in this Limited Warranty Statement are the customer’s 
sole and exclusive remedies.



iii
C. Limitations of Liability
1 EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THE LIMITED WARRANTY 

STATEMENT, IN NO EVENT SHALL MATROX BE LIABLE FOR:
a any direct, indirect, special, incidental, consequential, foreseeable or unforeseeable, or punitive damages, 

whether based on contract, tort, delict or any other legal theory and whether advised of the possibility of such 
damages; and/or

b damages arising from the loss of use, data, production revenue and/or profit of in connection with the Matrox 
product or any business interruption.

2 Without prejudice to the foregoing, any liability of Matrox for any breach of warranty shall be limited to the 
amount paid by the customer for the defective hardware in question.

3 To the extent allowed by local law, Matrox’s entire liability and the customer’s exclusive remedy shall be the 
repair or replacement of any defective product during the warranty period. Matrox does not offer any other 
warranty with respect to Matrox hardware or software or any other hardware or software.

4 Customer shall be responsible for all applicable taxes, duties and customs fees on any replacement unit, as well 
as all transport, insurance, storage and other charges incurred on all returned products.

D. Obtaining Service in North America
1 Verify that your Matrox product was installed and configured according to the information in its accompanying 

documentation.

2 Read the “Troubleshooting” information included with the Matrox product to see if you can solve the problem 
yourself.

3 If you are still experiencing difficulties, please contact your dealer where you purchased your Matrox product.

4 If you must return a Matrox product, leave the configuration as it was when you were using it, and leave all 
identification stickers on the product. Pack the product in its original box and return to your Matrox dealer where 
the product was purchased, together with your proof of purchase. Your Matrox dealer will return the product for 
you. Alternatively, if this first option is unavailable to you, you may contact the Matrox Technical Support group 
who will issue a Return Merchandise Authorization (RMA) number, upon receipt of adequate proof of purchase, 
and inform you of shipping instructions. DO NOT RETURN THE PRODUCT TO MATROX WITHOUT 
MATROX’S RMA NUMBER AND EXPRESS AUTHORIZATION.

E. Obtaining Service outside North America
1 Verify that your Matrox product was installed and configured according to the information in its accompanying 

documentation.

2 Read the “Troubleshooting” information included with the Matrox product to see if you can solve the problem 
yourself.

3 If you are still experiencing difficulties, please contact your dealer where you purchased your Matrox product.

4 If you must return a Matrox product, leave the configuration as it was when you were using it, and leave all 
identification stickers on the product. Pack the product in its original box and return to your Matrox dealer where 
the product was purchased, together with your proof of purchase. Your Matrox dealer will return the product for 
you.

F. General
This limited warranty shall be governed by the laws of the Province of Quebec, Canada and the federal laws of 
Canada applicable therein and the courts of the Province of Quebec shall have exclusive jurisdiction to hear and 
decide any dispute instituted by the customer in connection with this limited warranty; the customer waives, by 
accepting the product, its rights to institute proceedings in connection with this warranty against Matrox in any 
jurisdiction other than Quebec.
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Software license agreement
Single User Products. This Matrox software (the “Software”) is copyrighted by Matrox Electronic Systems 
Ltd. All rights are reserved. The purchaser is granted a license to use the software only, subject to the following 
restrictions and limitations.

1 The license is for the original purchaser only, and is not transferable without written permission of Matrox.

2 The original purchaser may use the Software on a single computer owned or leased by the original purchaser. 
You may not use the Software on more than a single machine, even if you own or lease more than one machine, 
without written consent of Matrox.

3 The original purchaser may make back-up copies of the Software for his or her own use only, subject to the use 
limitations of this license.

4 The original purchaser may not engage in, nor permit third parties to engage in, any of the following:

✄ Providing or disclosing the Software to third parties.

✄ Providing use of the Software in a computer service business, network, time-sharing, multiple CPU or multi-
user arrangement to users who are not individually licensed by Matrox.

✄ Making alterations or copies of any kind in the Software (except as specifically permitted above).

✄ Attempting to unassemble, de-compile or reverse engineer the Software in any way.

✄ Granting sublicenses, leases, or other rights in the Software to others.

✄ Making copies, or verbal or media translations, of the user’s guide.

✄ Making telecommunication data transmissions of the Software.

Matrox reserves the right to terminate this license if there is a violation of its term or default by the Original 
Purchaser. Upon termination, for any reason, all copies of the Software must be immediately returned to Matrox, 
and the Original Purchaser shall be liable to Matrox for any and all damages suffered as a result of the violation or 
default.

Limited warranty. Matrox warrants to you, for a period of ninety (90) days normal use from your date of 
purchase, that:

1 The CD/disks on which the software is furnished and the documentation are not defective.

2 The Software is properly recorded upon the CD/disks included.

3 The documentation is substantially complete and contains all the information Matrox deems necessary to use the 
software.

4 The Software functions substantially as described in the documentation.

Matrox’s entire liability and your exclusive remedy shall be the replacement of any CD/Disks or documentation not 
meeting these warranties, which is returned to Matrox or an authorized dealer, together with a copy of your paid 
receipt. The above is the only warranty of any kind, either express or implied, including, but not limited to the 
implied warranties of merchantability and fitness for a particular use that is made by Matrox on this Licensed 
Software. In no event shall Matrox be liable to you or to any third party for consequential, special, indirect or 
incidental damages which you may incur as a result of using the licensed software, including, but not limited to, loss 
of data, or information of any kind which you may experience.

This limited warranty shall be governed by the laws of the Province of Quebec, Canada and the federal laws of 
Canada applicable therein and the courts of the Province of Quebec shall have exclusive jurisdiction to hear and 
decide any dispute instituted by the customer in connection with this limited warranty; the customer waives, by 
accepting the product, its rights to institute proceedings in connection with this warranty against Matrox in any 
jurisdiction other than Quebec.
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Chapter

1
Introducing 
Matrox RTMac

This chapter outlines some of the features of your 
Matrox RTMac, lists the contents of your kit, and 
explains the organization of your Matrox RTMac 
documentation.
Welcome
Thank you for purchasing Matrox RTMac. When combined with Apple’s Final Cut Pro, 
Matrox RTMac provides professional-quality realtime editing, compositing, and effects.

Matrox RTMac features
• Realtime native DV editing with realtime broadcast-quality effects.

• Simultaneous display of video-in-a-window on your computer monitor and full-
resolution display on your NTSC or PAL video monitor.

• Lets you work with up to four layers in real time—two video layers and two graphics 
layers.

• Realtime processing including:
– transitions between video and/or graphics layers (includes cross dissolves, wipes, 

slides, and irises).

– up to two Motion Effects on video or graphics.

– opacity control on up to three layers.

• Realtime alpha-keyed titles and graphics.

• Analog video capture and output (composite and S-Video).

• Analog audio capture and output (stereo RCA).

• Video input and output at full resolution and frame rate.

• VGA output for connection to a VGA monitor.

• Support for standard 4:3 editing or 16:9 widescreen editing.
Welcome
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Hardware supplied

System requirements
Matrox RTMac requires the following minimum system configuration:

• Single or multi-processor Power Mac G4 with AGP motherboard.

• 400-MHz PowerPC G4 processor.

• 384 MB RAM.

• One free PCI slot.

• CD-ROM drive for software installation.

• Mac OS X 10.2.6 or later.

• Final Cut Pro 3 or later.

• QuickTime version 6.3 or later.

• Fast EIDE/Ultra ATA or SCSI disk drives—must be able to sustain two 
25-megabit/second streams.

The Matrox RTMac software detects the capabilities of your computer, and enables more 
realtime features on a faster system. To take full advantage of realtime editing on Matrox 
RTMac, use the following recommended system configuration:

• 667-MHz or faster PowerPC G4 processor.

• 512 MB RAM.

• Greater than 1 MB combined L2 and L3 cache (per processor).

• 133-MHz or faster system bus.

For information on the realtime capabilities of minimum and recommended systems, see 
“Realtime editing using Matrox RTMac” on page 21.

Check our web site for more information
For up-to-date information about your Matrox RTMac system, including updated drivers, 
you can check our web site at www.matrox.com/videoweb/support.

 RTMac card Breakout box RTMac cable

Matrox RTMac

Matrox RTMac
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Chapter 1, Introducing Matrox RTMac

http://www.matrox.com/videoweb/support
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About this manual
This manual explains how to install and use your Matrox RTMac system and included 
software.

Installation and configuration
Chapters 2 and 3 explain how to install your Matrox RTMac hardware and software, as well 
as how to configure your system for use with Matrox RTMac.

Using Matrox RTMac with Final Cut Pro
Chapter 4 gives you instructions for getting the most from Final Cut Pro and Matrox RTMac.

Using Matrox RTMac with Adobe After Effects and 
Discreet combustion
Chapter 5 explains how to configure Adobe After Effects and Discreet combustion for use 
with Matrox RTMac.

Troubleshooting
Chapter 6 provides some possible answers if you have trouble installing or operating your 
Matrox RTMac system.

Customer support and other information
Appendix A tells you how to contact us for customer support, and Appendix B provides 
Matrox worldwide sales contact information. Appendix C provides specifications for your 
Matrox RTMac system.

Style conventions
The following style conventions are used in this manual:

• The names of files, folders, and manuals appear in italics. For example:
– The data is stored in the Sample Movie file.

– The file is located in the Clips folder.

– Please refer to your Final Cut Pro User’s Manual.

• Menus and commands that you need to choose are displayed in the form Menu > 
Command. For example, File > Save means choose File in the menu bar, then choose 
Save in the menu that appears.

Last-minute information
Any important information that wasn’t available for inclusion in the manual by publication 
time is provided to you in the Release Notes packaged with this manual.
About this manual
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Three quick steps to getting started
The following steps summarize the installation procedure for your Matrox RTMac system.

¡ Important Please read the detailed instructions in each chapter before attempting the 
installation.

1 Install your Matrox RTMac card in your computer. See Chapter 2, “Installing Your 
RTMac and Connecting Your Devices.”

2 Connect your breakout box and other external devices, including your secondary 
monitor if you’ve chosen to use one. See Chapter 2, “Installing Your RTMac and 
Connecting Your Devices.”

3 Install QuickTime, Final Cut Pro, and the Matrox RTMac software, then configure your 
system. See Chapter 3, “Installing Your Software and Configuring Your System.”
Chapter 1, Introducing Matrox RTMac
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Chapter

2

Installing Your RTMac and 
Connecting Your Devices

This chapter describes how to install your Matrox 
RTMac hardware in your computer and connect 
your external devices.
Installing the Matrox RTMac card
Your Power Mac G4 has different types of expansion slots: AGP and PCI. Matrox RTMac is 
a PCI card, so you must install it in one of your free PCI slots. For more information on card 
installation and your computer’s expansion slots, see your Setting Up Your Power Mac G4 
guide.

³Warning Static electricity can severely damage electronic parts. Before touching any 
electronic parts, drain the static electricity from your body. You can do this by touching the 
metal portion of the PCI port access covers on the back of your computer. As well, be sure to 
hold your RTMac card by the edges, and avoid touching its circuitry and components.

1 Make sure your computer has been properly shut down. From the Apple menu, choose 
Shut Down and wait 5 minutes for the computer’s internal components to cool down.

2 Unplug the power cord. 
(You should never open your 
computer when its power is 
on.)

3 Lift the latch on the right side 
of the computer and carefully 
lower the side panel onto a flat 
surface.

4 Remove the screw that holds 
the port access cover in place 
and pull out the access cover.

Port access
cover
trox RTMac card
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5 Position your RTMac card over 
the PCI slot you’ve chosen, and 
properly align the connectors 
with the slot.

6 Push the card in firmly and 
evenly until it’s fully seated in its 
slot.

7 Re-insert the port access screw to 
secure your card to the computer 
frame.

8 Close the side panel making sure 
it snaps into place, and reconnect 
the power cord.

Connecting your Matrox RTMac breakout box
To connect your Matrox RTMac 
breakout box cable:

1 Plug the end labelled TO 
RTMAC BOARD into the socket 
on your RTMac card labelled 
VIDEO.

2 Plug the other end, labelled 
RTMAC/BOB/CBL, into the 
RTMac breakout box.

TO R O R
T boar

T board

TO R
T board

Matrox RTMac
Chapter 2, Installing Your RTMac and Connecting Your Devices
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Matrox RTMac breakout box overview
Your Matrox RTMac breakout box lets you make analog I/O connections to your external 
devices more easily. This is useful for changing your connection setup.

RT2000
Matrox RTMac

OUTPUT
RTMac 
cable 

connector Audio
Composite

S-Video
Left

R
ight

Composite S-Video
Audio

Le
ft

R
ig

ht

INPUT
Matrox RTMac breakout box overview
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Available S-Video and composite video connections
The Matrox RTMac breakout box has two composite video connectors (one input and one 
output), and two S-Video connectors (one input and one output). Most video equipment uses 
composite video, but some devices (for example, S-VHS VCRs) use S-Video, which 
provides a higher quality video signal.

If you have a video device with S-Video connectors, you should use the Matrox S-VIDEO IN 
and S-VIDEO OUT connectors on your breakout box. You can use the Matrox S-Video 
connectors instead of—or in addition to—the composite video connectors. If you use 
composite and S-Video connectors, you can connect up to four video devices to the RTMac 
at the same time (two input and two output).

Matrox RTMac video output is simultaneous on its composite (VIDEO OUT) and S-Video 
(S-VIDEO OUT) lines. Both video input types can be connected at the same time, but only 
one video input signal at a time can be used by RTMac. You need to select either the 
composite video input or the S-Video input signal in your Final Cut Pro audio/video settings. 
For more information on how to do this, see “Specifying your Matrox RTMac analog 
settings” on page 20.

S-VIDEO INVIDEO IN L - AUDIO IN - R

Matrox RTMac

VIDEO OUT L - AUDIO - R
OUT

S-VIDEO
OUT

MatroxRTMac

Composite S-Video S-Video Composite

Input Output
Chapter 2, Installing Your RTMac and Connecting Your Devices
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Composite input/output connections
1 To connect your composite video 

source (for capturing material), use 
either a composite audio/video 
(RCA) cable or three separate cables 
with RCA connectors.

a Connect the video output from 
your composite device to the 
yellow VIDEO IN jack on the 
breakout box.

b Connect the left audio output 
channel of your device to the white 
L-AUDIO IN jack on the breakout 
box.

c Connect the right audio output 
channel of your device to the red 
AUDIO IN-R jack on the breakout 
box.

¦ Note If your video device has only one audio connector, use the left audio connector 
on the cable.

2 To connect your composite video 
recorder, use another composite (RCA) 
audio/video cable or three more 
separate cables with RCA connectors.

a Connect the yellow VIDEO OUT jack 
on the breakout box to the video input 
on your video recorder.

b Connect the white L-AUDIO OUT 
jack on the breakout box to the left 
audio input of your video recorder.

c Connect the red AUDIO OUT-R jack 
on the breakout box to the right audio 
input of your video recorder.

VIDEO

OUT

AUDIO

OUT
L R

S-VIDEOVIDEO IN L - AUDIO IN - R

Matrox RTMac

Video camera 
or player

VIDEO

IN

AUDIO

IN
L R

VIDEO OUT L - AUDIO - R

OUT

S-VIDEO

OUT

MatroxRTMac

Video
recorder
Composite input/output connections
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3 To display the output from Matrox RTMac on your NTSC or PAL video monitor, you 
can connect your video monitor to the breakout box or your recorder. For an illustration 
of typical composite connections you can use, see “Composite connections using 
separate source and record devices” on page 12.

¦ Note You can use a TV in place of an NTSC or PAL video monitor. If your TV has a 
TV/VIDEO input switch, set it to VIDEO.

S-Video input/output connections
1 To connect your S-Video source (for 

capturing material), use an S-Video 
cable, as well as two cables with 
RCA connectors for audio.

a Connect the video output from your 
S-Video device to the S-VIDEO IN 
jack on the breakout box.

b Connect the left audio output 
channel of your device to the white 
L-AUDIO IN jack on the breakout 
box.

c Connect the right audio output 
channel of your device to the red 
AUDIO IN-R jack on the breakout 
box.

¦ Note If your video device has only one audio connector, use the left audio connector 
on the cable.

2 To connect your S-Video recorder, use another S-Video cable and two more cables with 
RCA connectors for audio.

a Connect the S-VIDEO OUT jack on the breakout box to the video input on your video 
recorder.

b Connect the white L-AUDIO OUT jack on the breakout box to the left audio input of 
your video recorder.

AUDIO

OUT
L R

S-VIDEO INVIDEO IN L - AUDIO IN - R

S-VIDEO

OUT

Matrox RTMac

Video camera or 
player
Chapter 2, Installing Your RTMac and Connecting Your Devices
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c Connect the red AUDIO OUT-R jack 
on the breakout box to the right audio 
input of your video recorder.

3 To display the output from Matrox 
RTMac on your NTSC or PAL video 
monitor1, you can connect your video 
monitor to the breakout box or your 
recorder.

FireWire connections
You can connect a FireWire device, such as a DV camcorder or VCR, to the FireWire port on 
your Power Mac G4 as explained in your Setting Up Your Power Mac G4 guide.

¡ Important When using Final Cut Pro with a FireWire setup, make sure your DV device is 
connected to the FireWire port on your Power Mac G4 before starting a capture or print to 
video. If your DV device isn’t connected when Final Cut Pro attempts to capture DV clips or 
record to DV tape, your system will become unstable. You’ll then need to quit and restart 
Final Cut Pro.

Connecting a secondary computer monitor
If you want to use a secondary VGA monitor with your system, such as to provide a second 
desktop display for dual-monitor editing, you can connect this monitor to your Matrox RTMac 
card. Your primary monitor is connected to the AGP graphics card that came with your Power 
Mac G4. Your secondary monitor connects to the standard 15-pin VGA connector on your 
RTMac card.

1 Plug the monitor cable into the smaller RTMac socket, which is labelled with a square 
monitor icon.

2 Plug the other end into your other monitor.

For information on properly configuring your secondary monitor for use with RTMac, see 
“Configuring a secondary monitor” on page 14.

1 You can use a TV in place of an NTSC or PAL video monitor. If your TV has a TV/VIDEO input 
switch, set it to VIDEO.

S-VIDEO

IN

AUDIO

IN
L R

VIDEO OUT

S-VIDEO

OUT
L - AUDIO - R

OUT

MatroxRTMac

Video
recorder
S-Video input/output connections
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Typical RTMac connections
The following illustration shows typical audio and video connections for capturing and 
recording to tape. In this illustration, we’ve connected a video monitor (NTSC or PAL) to 
view the signal that is being captured or recorded, and we’re monitoring audio from the 
video recorder to externally powered speakers.

Composite connections using separate source and 
record devices

Externally powered speakers (or audio mixer)

RL

Video monitor
or television

VCR

Video Recorder

VIDEO

VIDEO

VIDEO

AUDIO L

AUDIO R

S-VIDEO

OUT IN
IN

OUT

AUDIO L

AUDIO R

RTMac cable

To RTMac card

VIDEO IN

AUDIO IN
AUDIO OUT

RTMAC  CABLE
CONNECTOR

VIDEO OUT

L

L
R

R

RTMac breakout box

S-VIDEO
IN

S-VIDEO
OUT
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Chapter

3

Installing Your Software 
and Configuring Your 
System

This chapter explains how to install your software 
and configure various settings on your computer for 
use with Matrox RTMac.
Installation overview
Once you’ve installed your Matrox RTMac card and have properly connected your devices, 
you can proceed with your software installation and system configuration.

1 Install QuickTime and Final Cut Pro 3.

2 Install the Matrox RTMac software.

3 Configure your secondary monitor, if applicable.

4 Define your Matrox RTMac preferences.

Installing QuickTime and Final Cut Pro
1 Install Final Cut Pro 3 from your Final Cut Pro installation CD.

2 Install QuickTime 6.3 or later, available from the Apple web site (www.apple.com/
quicktime).

3 When prompted, restart your computer.

Installing the Matrox RTMac software
1 Insert the Matrox RTMac installation CD.

2 Double-click Matrox RTMac Installer to launch the install program, then follow the 
onscreen instructions.

¡ Important In order to install the Matrox RTMac software, the Matrox RTMac 
installer must delete your Final Cut Pro preferences file, and you will lose your custom 
settings. A new default preferences file will be created automatically when you first 
launch Final Cut Pro following the RTMac installation. You can then reconfigure your 
preferences as described in your Final Cut Pro User’s Manual. If you want to note your 
Final Cut Pro custom settings before the preference file is deleted, close the installer to 
cancel the Matrox RTMac installation.

3 When prompted, restart your computer.
allation overview
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¦ Note Be sure to check our web site (www.matrox.com/video) for the most recent 
RTMac software.

Configuring a secondary monitor
If you’ve connected a secondary monitor, you must configure it properly for use with Matrox 
RTMac. Your primary monitor is the monitor connected to the AGP graphics card that came 
with your Power Mac G4. Your secondary monitor is the monitor you’ve connected to your 
RTMac card.

Setting color depth and resolution
From the Apple menu, choose System Preferences, click Display, then click on the 
display preferences dialog box that appears on your secondary monitor.

• Colors For use with RTMac and Final Cut Pro, you can select a color depth of either 
Thousands or Millions depending on your resolution choice.

• Resolutions Sets the resolution for your secondary monitor. The maximum 
resolution for use with Matrox RTMac and Final Cut Pro depends on the color depth 
you select. 

– When color depth is set to Thousands, the maximum resolution you can select for your 
secondary monitor is 1280 × 1024.

– When color depth is set to Millions, the maximum resolution you can select for your 
secondary monitor is 1024 × 768.

• Refresh Rate Sets the refresh rate for your secondary monitor. For best performance, 
the maximum refresh rate you should select for your secondary monitor is 75 Hertz.
Chapter 3, Installing Your Software and Configuring Your System
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If you select a resolution and refresh rate that exceed these limits, you may encounter 
performance problems when using Final Cut Pro. As well, you cannot select a resolution 
greater than 1280 × 1024, even if your monitor supports this.

Defining your Matrox RTMac preferences
The Matrox RTMac preference pane lets you enable or disable RTMac functionality, select 
the video standard you want to use with your RTMac system (NTSC or PAL), and select 
your analog source type. 

¡ Important Before making any changes to your RTMac preferences, you must close Final 
Cut Pro and all other applications using RTMac, including applications using RTMac as a 
sound input or output device.

From the Apple menu, choose System Preferences, then click Matrox RTMac.

• Enable Matrox RTMac functionality Enables RTMac realtime functionality, and is 
selected by default. If, however, you want to use Final Cut Pro’s realtime software 
effects, you must clear this option to disable RTMac realtime functionality.

• Video Standard Specifies the video standard for your RTMac system (NTSC or 
PAL). Only clips that match your selected video standard will play back in real time. If 
you’re using an NTSC system, you must select one of the following NTSC setup levels 
for your analog video. This affects both the analog video input and output.

– 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.
Defining your Matrox RTMac preferences
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– 0 IRE Applies a setup level of 0 IRE. You should select this option only when working 
with a commercial DV device that uses the Japanese analog NTSC setup of 0 IRE. For 
example, if the video appears too bright when you play back DV clips on your NTSC 
monitor, you can change the setup to 0 IRE to output your DV clips at the correct 
brightness.

¦ Note If your device has a different NTSC setup level for input and output, you can 
switch the setup level as needed before capturing or recording to tape. If you’re not sure 
which setup level your DV device uses for input and output, check with your device’s 
manufacturer.

• Analog Source Type Specifies the type of equipment you have.

– Consumer-quality Select this if you have a consumer-grade source device that 
doesn’t have a time base corrector1 (TBC). RTMac will filter the video input signal to 
increase tolerance for sync pulse instability.

– Broadcast-quality Select this if your source device meets broadcast-quality 
standards, such as a device with a built-in time base corrector. This allows RTMac to 
digitize the input signal as-is.

1 A time base corrector (TBC) is an electronic device that, when connected to the output of a VTR, 
corrects the stability and timing of the VTR’s playback video. This is achieved by stripping the 
unstable horizontal and vertical sync pulses from the video signal, and replacing them with new, clean 
sync pulses.
Chapter 3, Installing Your Software and Configuring Your System
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Disabling Energy Saver mode
To ensure that your RTMac system works correctly, your computer and hard disk’s energy 
saver features (“sleep” modes) must be turned off. To disable these features:

1 From the Apple menu, choose System Preferences, then click Energy Saver.

2 On the Sleep tab, set the computer sleep slider to Never.

3 Make sure that Put the hard disk to sleep when possible is cleared. (You can, 
however, set a time to put the display to sleep.)

4 Close the dialog box to apply your settings.
Disabling Energy Saver mode
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Disabling background applications and 
defragmenting your hard drives

Applications that run in the background use system resources and can affect performance 
when editing using Final Cut Pro with Matrox RTMac, such as causing dropped frames 
during playback. As well, an overly fragmented hard drive can similarly affect performance. 
To avoid potential problems with system performance, we suggest you do some or all of the 
following:

1 Disable AppleTalk. From the Apple menu, choose System Preferences, then click 
Network. On the AppleTalk tab, clear Make AppleTalk Active if this option is 
selected.

2 Disable sharing. From the Apple menu, choose System Preferences, then click 
Sharing. On the Services tab, clear sharing options that aren’t needed while you’re 
editing.

3 Disable the network time server feature. From the Apple menu, choose System 
Preferences, then click Date & Time. On the Network Time tab, clear Use a 
network time server if this option is selected.

4 Defragment your hard drives.
Chapter 3, Installing Your Software and Configuring Your System
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Chapter

4

Using Matrox RTMac 
with Final Cut Pro

This chapter explains how to take advantage of 
Matrox RTMac’s realtime features using Final Cut 
Pro.
Defining your Matrox RTMac audio/video settings
Before you can begin working with Final Cut Pro, you must first specify your audio/video 
settings. The Matrox RTMac software installs presets configured for use with RTMac.

¡ Important If you uninstall the Matrox RTMac software, Matrox RTMac preset names will 
still appear in the Easy Setup and Audio/Video Settings dialog boxes, but the presets will 
be unusable. To remove the Matrox preset names, you must delete your Final Cut Pro 
preferences file.

Easy Setup
Final Cut Pro provides an Easy Setup feature that allows you to define your audio/video 
settings based on pre-defined configurations. Choose Final Cut Pro > Easy Setup. 
io/video settings
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From the Setup For pop-up menu, select the appropriate preset from the available RTMac 
settings, such as Matrox RTMac NTSC FireWire.

Matrox RTMac complements Power Mac G4 FireWire support by providing analog capture 
and output capabilities. When working with native DV footage and FireWire-compatible 
devices, you can capture your DV footage as you normally would using Final Cut Pro. You 
connect your DV device to your Power Mac G4 FireWire port and capture as explained in 
your Final Cut Pro User’s Manual. 

¡ Important When using Final Cut Pro with a FireWire setup, make sure your DV device is 
connected to the FireWire port on your Power Mac G4 before starting a capture or print to 
video. If your DV device isn’t connected when Final Cut Pro attempts to capture DV clips or 
record to DV tape, your system may become unstable. You’ll then need to quit and restart 
Final Cut Pro.

Specifying your Matrox RTMac analog settings
If you’re working with an analog source device, select the Matrox RTMac analog Easy Setup 
that matches your source device connection (composite or S-Video). You can also specify 
your analog setup by choosing Final Cut Pro > Audio/Video Settings and clicking the 
Summary tab.

From the Capture Preset pop-up menu, select the appropriate Matrox RTMac composite 
capture or S-Video capture preset.
Chapter 4, Using Matrox RTMac with Final Cut Pro
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When capturing or importing analog media files using Matrox RTMac, you must turn off 
audio sync compensation. Otherwise, you may encounter audio lag. Choose Final Cut 
Pro > Preferences, click the General tab and turn off Sync Adjust Movies Over, as 
shown below.

¦ Note For more information on Final Cut Pro audio/video settings, see your Final Cut Pro 
User’s Manual.

Analog capture with device control
Final Cut Pro supports different deck control protocols. For more information on analog 
capture with device control, see your Final Cut Pro User’s Manual.

Editing in 16:9
To capture and edit in 16:9 widescreen format, you must select Anamorphic 16:9 in both 
your capture presets and sequence settings. As well, your NTSC or PAL monitor must 
support 16:9 in order to see the correct aspect ratio.

Realtime editing using Matrox RTMac
Realtime means that you can play back and record your effects onto analog tape without 
having to render them. This gives you creative freedom to experiment with different effects 
and change your mind as often as you want. You’ll instantly see the changes you make on 
your NTSC or PAL video monitor and your computer monitor.

¦ Note The realtime features available on your Matrox RTMac system depend on the 
capabilities of your Power Mac G4. For details on minimum and recommended system 
requirements for realtime editing with RTMac, see “System requirements” on page 2.

Matrox RTMac lets you work with a maximum of four layers in real time in a given project. 
On a recommended system, you can use two video layers and two graphics layers. On a 
minimum system, you can use two video layers and one graphics layer, or one video layer 
and two graphics layers.

If you’ve surpassed the realtime editing capabilities of Matrox RTMac, the rendering status 
bar in the Final Cut Pro Timeline will change from green to red. In this case, you’ll need to 
render the effects that caused the bar to turn red. To do this, highlight the clips and render 
them using one of the methods described in your Final Cut Pro User’s Manual.

A yellow indicator in the rendering status bar indicates proxy realtime material. When you 
play back this material, Final Cut Pro will show a realtime approximation of the final effect. 
To see the final output, highlight the clips and choose Sequence > Render Selection to 
render the material. For more information on instances that require rendering, see “When 
you’ll need to render your effects” on page 23.

Some of the realtime effects Matrox RTMac gives you, and combinations you can use, 
include:
Realtime editing using Matrox RTMac
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• Video Transitions Realtime Video Transitions are shown in boldface in the Effects 
menu and the Effects tab of the Browser. These transitions include cross dissolve, 
irises, slides, and certain wipes.

• Motion Effects The number of simultaneous Motion Effects you can use in real time 
depends on the capabilities of your system.

– On a recommended system, you can use one Video Transition and two Motion Effects 
(without Motion Blur or drop shadow) at the same time without having to render. Only 
one of the Motion Effects can have rotation applied.

– On a minimum system, you can use one Video Transition and one Motion Effect 
(without Motion Blur or drop shadow) at the same time without having to render.

• Opacity You can change opacity settings on up to three layers on a recommended 
system, or up to two layers on a minimum system, without having to render. The 
number of layers on which you can control opacity depends on the number of 
simultaneous effects you’ve applied, as well as whether you’ve included graphics with 
alpha-channel information. However, you can always control opacity on at least one 
layer.

• Alpha Key You can alpha key up to two text or graphics layers in real time, provided 
you don’t exceed the maximum number of layers that will play back in real time on your 
system (minimum or recommended). All of the graphics file formats supported by Final 
Cut Pro can be imported for realtime text or graphics, such as an uncompressed PICT or 
TIFF file. For more information on file formats supported by Final Cut Pro, see your 
Final Cut Pro User’s Manual.

¡ Important If you want to use Final Cut Pro’s realtime software effects, you must disable 
Matrox RTMac functionality as explained in “Defining your Matrox RTMac preferences” on 
page 15.

A note about scrubbing on the Timeline
In most cases, you can scrub smoothly on the Timeline. However, scrubbing can become 
slow in the following cases:

• In sections containing proxy realtime effects (that is, where the rendering status bar is 
yellow).

• If the Viewer or Canvas window is set to a mode other than Image, such as 
Image + Wireframe. For smooth scrubbing, set the Viewer or Canvas window to 
Image mode.

• If you resize your Viewer or Canvas window so that the entire image doesn’t fit in the 
window, and scroll bars appear. For smooth scrubbing, resize the window so that the 
entire image fits and the scroll bars disappear, or set the image size to Fit to Window.
Chapter 4, Using Matrox RTMac with Final Cut Pro
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Allocating memory for graphics
Graphics are stored in RAM memory. The number of graphics you can work with in real 
time depends on the amount of RT Still Cache RAM you’ve allocated in your Final Cut Pro 
preferences. Increasing the amount of RAM lets you work with more graphics in your 
project.

When you’ll need to render your effects
In many cases, your Matrox RTMac effects will play back in real time. You will, however, 
need to render your effects when you do any of the following.

On a recommended system only
• Use more than two video layers and two graphics layers.

¦ Note If you place a clip with transparency (such as an alpha-keyed clip or a clip with 
a Motion Effect) on the lowest video layer in a segment on the Timeline, the clip will 
automatically be combined with a black video clip, which will count as an additional 
video layer.

• Use more than one Video Transition and two Motion Effects simultaneously.

• Use two Motion Effects with drop shadow applied to either one. Only one of the Motion 
Effects can have rotation.

On a minimum system only
• Use more than two video layers and one graphics layer, or one video layer and two 

graphics layers.

¦ Note If you place a clip with transparency (such as an alpha-keyed clip or a clip with 
a Motion Effect) on the lowest video layer in a segment on the Timeline, the clip will 
automatically be combined with a black video clip, which will count as an additional 
video layer.

• Use more than one Video Transition and one Motion Effect simultaneously.

On all systems
• Use any Motion Effect with Motion Blur applied.

• Use any Motion Effect and a wipe or iris transition simultaneously.

• Use a Motion Effect with drop shadow applied and a slide transition simultaneously.

• Include a still or graphics file that is larger than 720 × 480 (NTSC) or 720 × 576 (PAL), 
or include a graphics file in Adobe Photoshop format that contains more than one layer.

• Create a transition for which one of the sources has a Motion Effect, opacity, or alpha 
key applied.

• Set your audio playback quality to High, depending on the capabilities of your system 
(even if you’ve disabled RTMac functionality). To avoid having to render, make sure 
you use only audio clips sampled at 48 kHz. If you’re capturing audio, make sure your 
Realtime editing using Matrox RTMac
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source device’s audio sampling rate is set to 48 kHz. Check the documentation of your 
source device for instructions on changing your audio sampling rate.

• Place graphics clips on one layer with less than eight frames between the start of each 
clip, or place graphics on two layers with less than eight frames between the end of one 
clip and the start of the next. To avoid rendering, place your graphics using the 
guidelines shown in the following examples.

¦ Note Non-realtime segments in the Timeline (that is, segments that require rendering) are 
identified by a red rendering status bar.

At least eight frames between the 
start of each clip

At least eight frames between the end of one 
clip and the start of the next
Chapter 4, Using Matrox RTMac with Final Cut Pro
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Preparing your project for printing to video
Analog output
To record your project onto analog tape, connect your VCR inputs to the composite or 
S-Video outputs and RCA audio outputs on your Matrox RTMac breakout box, then choose 
File > Print to Video. If you want to add color bars, select In and Out points for your 
Timeline, or make other adjustments, choose File > Print to Video and make your 
selections. You can then press “Record” on your VCR and click OK in the Print to Video 
window to play back your Timeline.

FireWire output
¡ Important To record your project to a DV device, you must set the Final Cut Pro external 

video settings to Apple FireWire. Choose Final Cut Pro > Audio/Video Settings, click 
the External Video tab, and select Apple FireWire NTSC (720 × 420) or Apple FireWire 
PAL (720 × 576) from the View During Recording Using pop-up menu. As well, make 
sure your DV camcorder or deck is connected to the FireWire port on your Power Mac G4.

FireWire output requires that all effects on the Timeline be rendered before printing to video. 
You can render your effects manually by choosing Sequence > Render All; otherwise they 
will automatically be rendered when you choose File > Print to Video. Once your effects 
are rendered, the rendering status bar will turn blue-gray. You can then make your Print to 
Video selections (such as to add color bars), and record your project to your DV device.
Preparing your project for printing to video
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Chapter

5

Using Matrox RTMac with 
Adobe After Effects and 
Discreet combustion

This chapter explains how to configure Adobe 
After Effects and Discreet combustion for use with 
Matrox RTMac. 
Overview
Matrox RTMac lets you display your work in Adobe After Effects (version 5.5 or later) or 
Discreet combustion (version 2.1 or later) on your NTSC or PAL video monitor. This lets 
you see the exact color temperature, safe-title area, and any interlaced artifacts as you work.

¦ Note The speed at which RTMac outputs your After Effects or combustion material is 
system-dependent and can vary. The display on your NTSC or PAL monitor will not be at full 
frame rate, even on a faster system.

When you install the Matrox RTMac software, the RTMac software for Adobe After Effects 
and Discreet combustion is also installed. In order to use RTMac with these applications, you 
must first configure them as explained in the following sections.

Configuring Adobe After Effects for use with 
Matrox RTMac

1 In After Effects, choose After Effects > Preferences > Video Preview.

2 From the Output Device pop-up menu, select Matrox RTMac Video Out 
Component.

3 Next to Show Output, select During RAM Previews and For All Window Updates.

4 Select Including Renders.

Configuring Discreet combustion for use with 
Matrox RTMac

1 In combustion, choose Combustion > Preferences.

2 Under Host, click Framebuffer, and set Framebuffer Type to Matrox RTMac.

3 Select Use with RAM player and Update dynamically.
Overview
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Chapter

6

Matrox RTMac 
Troubleshooting

This chapter provides some possible answers if you 
have trouble installing your hardware or operating 
your Matrox RTMac system.
Up-to-date information
The following pages provide solutions to the most common problems that we’ve found. 
These solutions are also available in the RTMac Support section of our web site at 
www.matrox.com/video/videoweb/support. As new information becomes available, we’ll 
add it there first, so it’s always a good idea to check the site on a regular basis.

Multiple solutions
Some of the problems identified here may have more than one possible cause, and there are 
frequently several possible solutions.

³Warning Never open your computer system when its power is on!
date information
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Installation/configuration
The RTMac card does not fit

Possible cause New or unused slots If you’re installing your Matrox RTMac card 
in a new or previously unused slot, there may be considerable 
resistance as the card slides into the slot. This is normal.

Solution Install carefully Make sure that the card is perfectly aligned with 
the slot and push it in firmly but gently until it’s correctly seated.

Secondary monitor connected to RTMac card displays black 
screen

Possible cause Monitor does not support DDC DDC is a system that detects the 
type of monitor connected to a video or graphics card. Some older 
monitors do not support this system, in which case the RTMac driver 
will display a default set of resolutions and refresh rates. It’s possible 
that your monitor doesn’t support some of these resolutions. If you 
choose an unsupported resolution, your monitor will not sync and 
you’ll probably see a black screen.

Solution Check display settings From the Apple menu, choose System 
Preferences, click Displays, then select Show displays in menu 
bar. This will place icons for all connected monitors in the menu bar 
on your main monitor. You can then try different resolution and 
refresh rates for your secondary monitor until you find one that is 
supported.

¦ Note If your monitor is connected with a BNC cable, it will not support DDC. As well, 
DDC might not work properly if you’re using an adapter on your monitor cable.

Operation
There are no “Easy Setups” for Matrox RTMac in Final Cut 
Pro

Possible cause Matrox RTMac software not installed Check your system. If the 
Matrox RTMac software isn’t installed, the Matrox RTMac “Easy 
Setups” won’t be installed.

Solution Install Matrox RTMac software Run the Matrox RTMac 
installer on your Matrox RTMac CD to install the RTMac software.
Chapter 6, Matrox RTMac Troubleshooting
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Effects don’t play back in real time, or entire rendering 
status bar is red

Possible cause 1 Matrox RTMac software not installed Check your system. If 
the Matrox RTMac software isn’t installed or didn’t load on startup, 
your effects won’t play back in real time.

Solution Install Matrox RTMac software Run the Matrox RTMac 
installer on your Matrox RTMac CD to install the Matrox RTMac 
software.

Possible cause 2 Wrong video standard selected in Matrox RTMac preference 
pane If the video standard you selected in the Matrox RTMac 
preference pane doesn’t match your source material, your effects 
won’t play back in real time.

Solution Select the correct video standard Close Final Cut Pro. From 
the Apple menu, choose System Preferences, click 
Matrox RTMac, and select the video standard (NTSC or PAL) that 
matches your source material.

Possible cause 3 Matrox RTMac functionality disabled Clearing Enable Matrox 
RTMac functionality in the Matrox RTMac preference pane 
disables RTMac functionality.

Solution Enable RTMac functionality Close Final Cut Pro. From the 
Apple menu, choose System Preferences, click Matrox RTMac, 
and select Enable Matrox RTMac functionality.

Possible cause 4 Incorrect External Video setting In order to use realtime effects, 
External Video must be set to Matrox RTMac. This outputs video to 
the breakout box.

Solution Change External Video setting Choose Final Cut Pro > 
Audio/Video Settings and click the Summary tab. From the 
External Video menu, select Matrox RTMac.

Video appears too bright on playback (NTSC only)
Possible cause Wrong NTSC setup level If you’re using a DV device that uses the 

Japanese analog NTSC setup of 0 IRE but you’ve selected the 
standard NTSC setup level of 7.5 IRE, video might appear too bright 
when you play back DV clips on your NTSC monitor.

Solution Change NTSC setup level Close Final Cut Pro. From the Apple 
menu, choose System Preferences, and click Matrox RTMac. 
Under Video Standard, select 0 IRE next to NTSC with setup 
level of.
Multiple solutions
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You receive a message that your Matrox RTMac could not 
be started

Possible cause 1 Your card isn’t installed properly If your Matrox RTMac card 
isn’t properly seated in its slot, your Power Mac G4 won’t detect it on 
startup and will display a message saying that Matrox RTMac could 
not be started because of an error.

Solution Ensure that your RTMac card is installed properly Shut down 
your computer and check to see if the RTMac card is fully seated in 
its slot.

Possible cause 2 “Multiple reset” error If you rapidly press the reset button on 
your Power Mac G4 more than once, your RTMac card may not 
initialize properly. This causes your system to assume that the 
RTMac card isn’t installed properly.

Solution Shut down your computer and restart From the Apple menu, 
choose Shut Down and restart your computer.

Scrubbing on the Timeline becomes slow
Possible cause 1 Scrubbing proxy realtime effects Scrubbing can become slow 

when you’re scrubbing over proxy realtime effects (that is, when the 
rendering status bar is yellow). This is normal.

Solution Render proxy realtime effects Highlight the effects and choose 
Sequence > Render Selection.

Possible cause 2 Unsupported Viewer or Canvas window settings If the 
Viewer or Canvas window is set to a mode other than Image, such 
as Image + Wireframe, scrubbing can become slow. Scrubbing can 
also become slow if you resize your image so that it doesn’t fit in the 
Viewer or Canvas window, and scroll bars appear.

Solution Change Viewer or Canvas window settings Set the Viewer or 
Canvas window to Image mode. If needed, resize the window so 
that the entire image fits and the scroll bars disappear, or set the 
image size to Fit to window.
Chapter 6, Matrox RTMac Troubleshooting
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Playback appears jerky (dropping frames)
Possible cause “High Quality Playback (slower)” option selected in render 

quality settings If you’ve selected High Quality Playback 
(slower) in your render quality settings, each frame will be rendered 
as it’s played back, instead of playing back in real time. This causes 
playback to appear jerky, with dropped frames.

Solution Check render quality settings Choose Sequence > Render 
Quality > Edit Render Qualities. In the Render Quality Editor, 
clear the High Quality Playback (slower) option on all available 
render quality setting tabs.

Loss of frame accuracy when capturing from an analog 
source with device control

Possible cause Analog source not genlocked to Matrox RTMac analog 
output If your analog deck isn’t genlocked to RTMac’s analog 
output, capture can be off by a few frames.

Solution Genlock analog source to RTMac output Connect the REF IN 
of your analog source device to the VIDEO OUT or S-VIDEO OUT of 
the RTMac breakout box. This will ensure capture accuracy to a 
single frame.

Audio input levels too high when using an XLR source 
device

Possible cause Wrong XLR-to-RCA converters Because the RTMac breakout box 
has line-level (RCA) audio inputs, connecting an XLR device to the 
inputs without the correct XLR-to-RCA converters results in input 
levels that are too high (“hot”).

Solution Use correct XLR-to-RCA converters Use XLR-to-RCA 
converters that attenuate the audio signal.
Multiple solutions
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A
mentation, please 
uickly correct any 
Matrox RTMac Customer 
Support
If you have a problem that you’re unable to solve by referring to your RTMac docu
contact your Matrox RTMac representative. He or she should be able to help you q
installation or system configuration problem. If your representative is unable to solve your problem, 
contact Matrox for further assistance.

Register your Matrox RTMac
Only customers who’ve registered their RTMac are eligible to receive customer support. You can 
easily register on our web site at www.matrox.com/video in the Support section.

Registering your RTMac also entitles you to free software upgrades, special promotional offers, and 
access to the Matrox RTMac User Forum, our dynamic web forum for users who want to share their 
experiences and learn more about Matrox RTMac.

In addition to registering your RTMac, our web site offers you up-to-the-minute information about 
Matrox products, free software updates, and access to our support databases. Be sure to place our site 
in your favorites or bookmarks: www.matrox.com/video.

Contacting us
Matrox is proud to offer worldwide technical support. Please use the contact information for your 
area. The following numbers are subject to change. For up-to-date contact information, always check 
our web site at www.matrox.com/video.

United States & Canada
Telephone ....................................................................................................... 1 514 822-6245
Fax .................................................................................................................. 1 514 685-2853
Email ............................................................................................. rtmacsupport@matrox.com

Europe, Middle East, & Africa
Telephone
Calls from the U.K. ............................................................................................ 01753 665678
Calls from France............................................................................................. 01 45 60 88 66
Calls from Germany ........................................................................................089 62 17 05 70
Calls from the rest of Europe, Middle East, & Africa .....................................+44 1753 665678
Fax
From the U.K......................................................................................................01753 665599
From the rest of Europe, Middle East, & Africa............................................ +44 1753 665599
Email
From Europe, Middle East, & Africa...................................... rtmac.tech.europe@matrox.com

All other countries
Telephone ....................................................................................................... 1 514 822-6245
Fax .................................................................................................................  1 514 685-2853
Email ............................................................................................. rtmacsupport@matrox.com
stomer Support

http://www.matrox.com/video
http://www.matrox.com/video
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Matrox Around the World
e Headquarters
Matrox Electronic Systems Ltd., Video Products Group
1055 St. Regis Blvd 
Dorval, Quebec 
Canada, H9P 2T4 
tel: 800 361-4903 (North America) 
      514 685-2630 ext. 2036 (Worldwide) 
fax: 514 685-2853 
Email: video.info@matrox.com

Europe, Middle East, Africa
Matrox Video and Imaging Technology Europe
Sefton Park 
Stoke Poges 
Buckinghamshire 
SL2 4JS 
United Kingdom 
tel: +44 (0)1753 665577
fax: +44 (0)1753 665599 
Email: video.info.emea@matrox.com 

France
Matrox France SARL
2, rue de la Couture 
Silic 225 
94528 Rungis Cedex 
tel: +33 (0)1 45 60 62 08 
fax: +33 (0)1 45 60 88 65 
Email: infovideo@matrox.com 

Germany
Matrox Electronic Systems GmbH
Inselkammerstraße 8 
D-82008 Unterhaching bei 
Munchen, Germany 
tel: +49 (0) 89 62 17 05 70 
fax: +49 (0) 89 61 49 74 3 
Email: video.info.emea@matrox.com 

Asia
Matrox Asia Liaison, Beijing Representative Office
#1608, 138A Haidian Road 
Beijing, China 100086 
Tel: (86-10) 6256 4853 
Fax: (86-10) 6253 6251 
Email: myang@matrox.com

The information on this page is 
subject to change. 

For up-to-date contact information, 
always check our web site at 
www.matrox.com/video.
trox Around the World

mailto:video.info@matrox.com 
mailto:video.info.emea@matrox.com 
mailto:infovideo@matrox.com 
mailto:video.info.emea@matrox.com 
mailto:myang@matrox.com 
www.matrox.com/video
www.matrox.com/video
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Matrox RTMac 
Specifications
Video
Inputs Composite video (CVBS), RCA jack

S-Video (Y/C), mini-DIN
NTSC, PAL

Outputs Composite video (CVBS), RCA jack
S-Video (Y/C), mini-DIN
NTSC, PAL

Video formats ITU-R 601 (YUV 4:2:2 internal data paths)
NTSC: 720×480 at 29.97 frames/sec.
PAL: 720×576 at 25 frames/sec.
4:3 and 16:9 aspect ratios

Video overlay Programmable NTSC and PAL video-in-a-window support on console at 
30/25 images/sec.

Video codec Multi-format codec supports single-stream capture and dual-stream play-
back of mini DV, DV, and DVCAM (NTSC 4:1:1 and PAL 4:2:0).

Audio
Genlock to video Audio clock locked to video clock for perfect sync

Analog audio input/output Unbalanced stereo I/O (1 pair RCA in, 1 pair RCA out) 

Sampling method 16 bit, 48 kHz, 64× oversampling 

VGA display
Output Standard 15-pin VGA connector.

Environmental specifications
Minimum/maximum ambient operating temperatures 0 to 55º C

Minimum/maximum storage temperature –40 to 75º C

Maximum altitude for operation 3,000 meters

Maximum altitude for transport 12,000 meters

Operating humidity 20 to 80% relative humidity*

Storage humidity 5 to 95% relative humidity*

* non-condensing
c Specifications
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Index

Numerics
16:9 editing 21

A
Adobe After Effects

configuring for use with Matrox RTMac 27

Analog output
printing to video 25

Analog settings
specifying 20

Anamorphic 16:9 editing 21

Audio/Video settings
defining 19
Easy Setup 19
specifying analog settings 20

B
Background applications

disabling 18

Breakout box
connecting 6
overview 7

C
Capture presets

selecting 20

combustion
See Discreet combustion

Composite video device
as source in Final Cut Pro 20
available connections 8
connecting recorder 9
connecting source 9

Connections
breakout box 6
composite video 8, 9

FireWire 11
secondary computer monitor 11
S-Video 8, 10
typical audio and video 12

Customer support iii

D
Discreet combustion

configuring for use with Matrox RTMac 27

E
Easy Setup

See Audio/Video settings

Editing in 16:9 21

Energy Saver mode, disabling 17

F
Final Cut Pro

audio/video settings 19
installing 13
preparing project for printing to video 25
realtime editing 21
realtime software effects, using 22

FireWire
connections 11
printing to video 25

G
Graphics

allocating memory for 23

H
Hard drives

defragmenting 18

Hardware
supplied with Matrox RTMac 2
dex
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I
Installation 5

overview 4

L
License agreement iv

M
Matrox

contacting us 35

Matrox RTMac breakout box
See Breakout box

Matrox RTMac card
features 1
installation 5

Matrox RTMac preferences
defining 15

Monitor (secondary computer)
configuring 14
connecting 11

N
NTSC setup level

selecting 15

NTSC video standard
selecting 15

P
PAL video standard

selecting 15

Preference pane (Matrox RTMac)
See Matrox RTMac preferences

Printing to video
analog output 25
FireWire output 25

Q
QuickTime

installing 13

R
Realtime editing 21

available effects 21
Final Cut Pro realtime software effects, 
using 22
when you’ll need to render your effects 23

Rendering
rendering status bar 21
when you’ll need to render your effects 23

RTMac card
See Matrox RTMac card

RTMac preference pane
See Matrox RTMac preferences

S
Scrubbing

a note about 22

Secondary computer monitor
See Monitor (secondary computer)

Service
returns iii

Sleep mode
See Energy Saver mode

Software
installing 13
license agreement iv

Source type
selecting 16

Style conventions 3

S-Video device
as source in Final Cut Pro 20
available connections 8
connecting recorder 10
connecting source 10
Index
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In
System requirements 2

T
Troubleshooting

installation/configuration 30
operation 30

V
Video standard

selecting 15

W
Warranty ii

Widescreen editing 21

WWW site 2, 14, 35
dex



Compliance Statements
USA
FCC Compliance Statement
Remark for the Matrox hardware products supported by this guide These devices have been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment causes harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: • Reorient or relocate the receiving antenna • Increase the 
separation between the equipment and receiver • Connect the equipment into an outlet on a circuit different from that to which the receiver is connected • Consult the dealer or an 
experienced radio/TV technician for help.

WARNING Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The use 
of shielded cables for connection of the monitor to the card is required to meet FCC requirements.

Declaration of conformity of a Class B digital device according to the FCC rules
We, the Responsible Party Matrox, 1075 Broken Sound Parkway, Boca Raton, FL 33487 • Telephone: (561) 989-9626 • Attention: Conformity Group Matrox

Declaration The Matrox hardware products supported by this guide comply with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) these devices may 
not cause harmful interference, and (2) these devices must accept any interference received, including interference that may cause undesired operation. Any question regarding this 
declaration should be forwarded to the above coordinates.

Canada
(English) Industry Canada Compliance Statement
Remark for the Matrox hardware products supported by this guide These digital devices do not exceed the Class B limits for radio noise emission from digital apparatus 
devices set out in the Radio Interference Regulation of Industry Canada.

(Français) Conformité avec les exigences du ministère de l’Industrie Canada
Remarque sur les produits matériels Matrox couverts par ce guide Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux 
appareils numériques de Classe B prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

Japan
VCCI Compliance Statement
Remark for the Matrox hardware products supported by this guide These are Class B products based on the standard of the Voluntary Control Council for Interference from 
Information Technology Equipment (VCCI). If these are used near a radio or television receiver in a domestic environment, they may cause radio interference. Install and use the 
equipment according to instructions in the manual.

Europe
(English) European user’s information – Declaration of Conformity
Remark for the Matrox hardware products supported by this guide These devices comply with EC Directive 89/336/EEC for a Class B digital device. They have been tested and 
found to comply with EN55022/CISPR22 and EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to 
take adequate measures.To meet EC requirements, shielded cables must be used to connect the monitor and other peripherals to the card. These products have been tested in a typical 
class B compliant host system. It is assumed that these products will also achieve compliance in any class B compliant system.

(Français) Informations aux utilisateurs Européens – Déclaration de conformité
Remarque sur les produits matériels Matrox couverts par ce guide Ces unités sont conformes à la directive communautaire 89/336/EEC pour les unités numériques de classe B. 
Les tests effectués ont prouvé qu’elles sont conformes aux normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces produits dans un environnement résidentiel peut 
causer des interférences radio, dans ce cas l’utilisateur peut être amené à prendre les mesures appropriées. Pour respecter les impératifs communautaires, les câbles de connexion entre 
le moniteur ou autres périphériques et la carte doivent être blindés. Ces produits ont été testés dans un système hôte typique compatible classe B. On suppose qu’ils présenteront la même 
compatibilité dans tout système compatible classe B.

(Deutsch) Information für europäische Anwender – Konformitätserklärung
Anmerkung für die Matrox Hardware-Produktunterstützung durch dieses Handbuch Diese Geräte entsprechen EC Direktive 89/336/EEC für ein digitales Gerät Klasse B. Sie 
wurden getestet und entsprechen demnach EN55022/CISPR22 und EN55024/CISPR24. In einer Wohnumgebung können diese Produkte Funkinterferenzen erzeugen, und der Benutzer 
kann genötigt sein, entsprechende Maßnahmen zu ergreifen. Um EG-Anforderungen zu entsprechen, müssen zum Anschließen des Monitors und anderer Peripheriegeräte an die Karte 
abgeschirmte Kabel verwendet werden. Diese Produkt wurden in einem typischen, der Klasse B entsprechenden, Host-System getestet. Es wird davon ausgegangen, daß diese Produkte 
auch in jedem Klasse B entsprechenden System entsprechend funktionieren.

(Italiano) Informazioni per gli utenti europei – Dichiarazione di conformità
Nota per i prodotti hardware Matrox supportati da questa guida Questi dispositivi sono conformi alla direttiva CEE 89/336/EEC relativamente ai dispositivi digitali di Classe 
B. Sono stati provati e sono risultati conformi alle norme EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare radiointerferenze, nel 
qual caso all’utente potrebbe venire richiesto di prendere le misure adeguate. Per soddisfare i requisiti CEE, il monitor e le altre periferiche vanno collegati alla scheda grafica con cavi 
schermati. Questi prodotti sono stati provati in un tipico sistema host conforme alla classe B. Inoltre, si dà per scontato che questi prodotti acquisiranno la conformità in qualsiasi sistema 
conforme alla classe B.

(Español) Información para usuarios europeos – Declaración de conformidad
Observación referente a los productos de hardware de Matrox apoyados por este manual Estos dispositivos cumplen con la directiva de la CE 89/336/EEC para dispositivos 
digitales de Clase B. Dichos dispositivos han sido sometidos a prueba y se ha comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos 
residenciales, estos productos pueden causar interferencias en las comunicaciones por radio; en tal caso el usuario deberá adoptar las medidas adecuadas. Para satisfacer las 
disposiciones de la CE, deberán utilizarse cables apantallados para conectar el monitor y demás periféricos a la tarjeta. Estos productos han sido sometidos a prueba en un típico sistema 
anfitrión que responde a los requisitos de la clase B. Se supone que estos productos cumplirán también con las normas en cualquier sistema que responda a los requisitos de la clase B.
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